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Lesson 3 - Processing a Multi-Layer Yield History

Exercise 3-2

Objective: Import one year of yield data and develop an interpolated normalized surface.

I.

For this exercise, Boundary.zip and Yield.zip files should be downloaded and unzipped.
The shape layer, Boundary, has four files. The Yield archive contains five years of
processed yield data. In this field, corn was grown every odd year and soybean was
produced in even years.

Open Manifold. Choose File-Import-Drawing. In the popup Import Drawing dialog
box, select SHP Files (*.shp) in the Files of type box and navigate to the Boundary.shp
file. Click Open. In the popup Import SHP File dialog box, click OK.

Choose File-Import-Table. In the Import Table dialog box, select CSV Files
(*.acs, *.scv, %.tab, *.txt) in the Files of type box and navigate to the Yield 2002s.txt file.
Click Open. In the popup CSV Import dialog box, click OK.

Right click the Yield 2002s table component in the Project pane and select Copy in the
popup menu. Right click any empty location in the Project pane and select Paste As —
Drawing in the popup menu to convert the table to a drawing. In the Paste As Drawing
dialog box, click OK.

In this example, a header line was used to recognize latitude and longitude coordinate
columns. If the header line does not exist in the input file, proper numbered columns
should be identified as geographical coordinates.

Right click Yield 2002s 2 drawing component in the Project pane and select Assign
Projection. In the popup Assign Projection dialog box, click OK. Right click the
Yield 2002s 2 drawing component again and select Change Projection. In the popup
Change Projection dialog box, navigate to Universal Transverse Mercator - Zone
14(N). Click plus the next to the Universal Transverse Mercator folder to see the list of
zones. Click OK.

Right Click any empty location in the Project pane and select Create-Map. In the popup
Create Map dialog box, write Yield 2002 in the Name box and make sure both
checkboxes (next to the Boundary and Yield 2002s drawing components) are marked.
Click OK.

Double-click the Yield 2002 map component in the Project pane. Expand the map by
clicking the Maximize button at the top right corner of the map window. Click the Zoom
To Fit icon. The following screen should appear:
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8. Click the Area Background icon and select X.
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9. Click the Area Border Foreground icon and change the color to Orange. Click the
Area Border Size icon and change the border size to 3.
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This way, the appearance of the field’s boundary is changed.
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10. Click the Yield 2002 tab at the bottom of the viewing window. Click the Point Size icon
and select 2. Click the Point Style and select Solid. Click the Point Foreground icon
and select Theme.
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11. In the popup Format dialog box, select the Yield in Field menu box. Choose the Dark
Blues to Yellows pallet in the drop-down Pallet menu box. Click the Apply icon. Click
the Reverse icon. Click OK.

Format =]
Field: [vield =
Methiod: [Equal Count |

Palstte: [

= A ) =

1es[_|
1505 ]
3397 ]
Apply 4354
1oz [
el |
Reverse
™ Continuaus shading
¥ alignto |0 _lj digits (1.0}
Range: [2.596 i[oms | Reset
Breaks: [5 =) Tally

I Preview Cancel

The modified yield map should appear as follows:
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12. Interpolate the map and trim it to the extent of the field. Right click the Yield 2002s
drawing component in the Project pane and select Copy. Right click any empty location
in the Project pane and select Paste As-Surface. In the popup Paste As Surface dialog
box select Yield in the Height pull down menu. Set the Margins 70 by 10 meters and the
Pixel size 5 by 5. Select No Interpolation method in the Method pull down menu. Click

OK.
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Surface resolution can be higher or lower than 5 m. When larger pixels are selected,
certain data details will be smoother. Smaller size of pixels will require a longer time for
computation.

13. Click the Yield 2002s 3 surface component in the Project pane and drag it to the map.
Double click the Yield 2002s tab at the bottom of the viewing window. This will hide the
yield points from the map and the raw yield data in raster (pixel) format will appear as

follow:
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14. Click the Yield 2002s 3 tab. In Transform Toolbar, select All Pixels in Yield 2002s 3 in
the Target menu and Interpolate in the Operator menu. Click Apply. This will fill the
entire viewing window with yield pixels according to the nearest neighbor rules.
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15. In Transform Toolbar select All Pixels in Yield 2002s 3 in the Target menu and
Median Square in the Operator menu. Click Apply. This will cause the surface to
appear smooth without the averaging effect.
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16. To select the boundary that should be used to retain pixels inside the field, click the
Boundary Drawing tab. Click inside the boundary to be selected.
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17. Click the Yield 2002s 3 Surface tab. From the Surface menu, choose Transfer Selection.
In the popup Transfer Selection dialog box, click OK. From the Edit menu, choose
Select Inverse. Press the Delete key on the keyboard. Click the Boundary Drawing tab
again and click the Select None icon.
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This process allows deleting every pixel of the interpolated surface outside the field
boundary. The resulting surface can be used for calculations, or to create a contour map.



Application of Manifold GIS Software for Precision Agriculture
Viacheslav 1. Adamchuk and Abbas Hemmat

18. Click the Yield 2002s 3 surface tab. From the View menu, choose Display Options. In
the popup Display Options dialog box choose Dark Blues to Yellows from the drop-
down Palette. Click the Apply icon. Click the Reverse icon. Unselect Shading. Click
OK.
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The resulting colored Yield2002s 3 surface is shown below:
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From the Surface menu, choose Transfer Heights. In the popup Transfer Heights
dialog box, make sure Boundary Drawing is listed as the target and click OK. This
process will calculate the average yield and record it as a new column in the database
table related to the Boundary Drawing.
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19. Double click the Boundary Table component in the Project pane. Right click the Height
column heading and choose Rename.
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20. In the popup Column Name dialog box, type 2002 in the Change To box and click OK.
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21. Double click the value corresponding to the average yield, then right click it and select

4 4[ah_Manifold_project_3-2 *] - Manifold System - [Boundary Table *]

[ File Edit View Table Tools Window Help

Deswdlo=ls merex(ale|= s
K 4 » M >ne\v*‘*z|

[ |m2  [zom2 |
N 551 39340
% cut
Copy
B Paste
=

22. Double click the Yield 2002 map component in the Project pane. Click the Yield 2002s
3 tab. From the Surface menu choose Transform. In the popup Transform dialog box,
double click Yield 2002s 3 in the Surface box. At the end of appeared in Formula box
[Yield 2002s 3], type “/” and then right click and choose Paste. Click OK.
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This formula will normalize the surface with respect to the field average.

23. From the View menu, choose Display Options. In the popup Display Options dialog
box, click the Apply icon and Reverse icon. Click OK.
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The normalized yield surface will look similar to the raw yield surface.
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24. Save As Project 3-2.map.

25. Repeat the same steps for other years.




<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /All
  /Binding /Left
  /CalGrayProfile (Dot Gain 20%)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Warning
  /CompatibilityLevel 1.4
  /CompressObjects /Tags
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJDFFile false
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /ColorConversionStrategy /LeaveColorUnchanged
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /SyntheticBoldness 1.00
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveEPSInfo true
  /PreserveHalftoneInfo false
  /PreserveOPIComments false
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Preserve
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 300
  /ColorImageDepth -1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasGrayImages false
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasMonoImages false
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 1200
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects false
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile ()
  /PDFXOutputCondition ()
  /PDFXRegistryName (http://www.color.org)
  /PDFXTrapped /Unknown

  /Description <<
    /FRA <>
    /ENU (Use these settings to create PDF documents with higher image resolution for improved printing quality. The PDF documents can be opened with Acrobat and Reader 5.0 and later.)
    /JPN <FEFF3053306e8a2d5b9a306f30019ad889e350cf5ea6753b50cf3092542b308000200050004400460020658766f830924f5c62103059308b3068304d306b4f7f75283057307e30593002537052376642306e753b8cea3092670059279650306b4fdd306430533068304c3067304d307e305930023053306e8a2d5b9a30674f5c62103057305f00200050004400460020658766f8306f0020004100630072006f0062006100740020304a30883073002000520065006100640065007200200035002e003000204ee5964d30678868793a3067304d307e30593002>
    /DEU <>
    /PTB <>
    /DAN <>
    /NLD <>
    /ESP <>
    /SUO <>
    /ITA <>
    /NOR <>
    /SVE <>
  >>
>> setdistillerparams
<<
  /HWResolution [2400 2400]
  /PageSize [612.000 792.000]
>> setpagedevice


